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Copyright

EVS Broadcast Equipment S.A.— Copyright © 2003-2015. All rights reserved.

Disclaimer

The information in this manual is furnished for informational use only and subject to
change without notice. While every effort has been made to ensure that the information
contained in this user manual is accurate, up-to-date and reliable, EVS Broadcast
Equipment cannot be held responsible for inaccuracies or errors that may appear in this
publication.

Improvement Requests

Your comments will help us improve the quality of the user documentation. Do not
hesitate to send improvement requests, or report any error or inaccuracy on this user

manual by e-mail to doc@evs.com.

Regional Contacts

The address and phone number of the EVS headquarters are usually mentioned in the
Help > About menu in the user interface.

You will find the full list of addresses and phone numbers of local offices either at the end
of this user manual (for manuals on hardware products) or at the following page on the
EVS website: http://www.evs.com/contacts.

User Manuals on EVS Website

The latest version of the user manual, if any, and other user manuals on EVS products
can be found on the EVS download center, on the following webpage:
http://www.evs.com/downloadcenter.
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What's New?

In the User Manual the icon has been added on the left margin to highlight
information on new and updated features.

The changes linked to new features in version 2.5 are listed below.

Content Check now writes files to the AppData folder instead of it's own
executable folder.

Content Check has been adapted to support the move of assets in Media Manager.

What's New?






USER MANUAL MAD 1.5 Content Check I / .

1.

About the Application

General Description

Content Check forms part of the ingest module of the central archiving system
MediArchive Director or MAD. It is used to monitor content checks performed by Interra
Systems' quality check software Baton on high-resolution video files that have just been
ingested into the digital archive.

It lists the faulty segments and provides a detailed error report per segment. It enables the
user to play back a low-resolution version of the erroneous video files and to manually
accept or reject them. Video files that are rejected will have to be purged from the digital
archive. Video files that are accepted will remain available in the digital archive.

Workflow

Description

The Content Check workflow proceeds as follows:

1. The automated application Content Check Controller scans the MAD database for
content check requests.

2. If the high-resolution video files that need to be checked are available on the online
storage, Content Check Controller requests Baton to perform the content checks.

3. Baton checks the audio and video quality of the specified video files on the online
storage.

Baton enters the status of the requested checks in the MAD database.

Content Check Controller picks up the updated status of the requested content
checks in the MAD database. In Content Check, the progress and the status of the
requested content checks can be monitored. In Media Manager, a green bar appears
under the Content Check icon if a segment has passed the content check
successfully. See the Media Manager user manual for more information.

6. In Content Check, the user has to manually accept or reject segments for which errors
have been detected. The status of the content check requests is then updated in the
MAD database.

7. InMedia Manager, the status of the corresponding asset item automatically turns into
‘Baton QC Rejected’ if a segment is rejected in Content Check and a red bar appears
under the Content Check icon. A purge can be requested for the segment.

1. About the Application 1
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Diagram

The diagram below illustrates the Content Check workflow.

U & o

MAD Databaze Content Check Controller

Baton Werfication Manager I

Baton Checker Pool

Multiple Timecode Support

Ch

Content Check

XStore SAM

Online Archive

The application supports the following SMPTE timecodes:

« PAL
*  NTSC non-drop frame
*  NTSC drop frame

2. About Baton

Baton by Interra Systems is an automated verification system for file-based content.
Baton enables content developers, studios, and broadcasters to minimize manual quality
checks on content and automate quality checks for file-based workflows. With Baton's
automated content verification, broadcasters and content developers can assure quality
media for distribution. For more information about Baton see the manuals provided by the

manufacturer.

2. About Baton
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3. Installing the Application

See the MAD Installation manual for more information on how to install the application.

4, Starting the Application

4.1. After Installation

To start the application after installation, proceed as follows:
&)
1. Double-click the Content Check icon &;g on the server desktop to start the
application. You can also launch the application by double-clicking the executable file
(.exe) in the installation folder.

The application splash screen appears while the application logs into the
MAD database.

MediArchive.Oirector

Version: O1.05

Content Check

Logging on to ..

Then, the Settings window appears allowing you to configure the application. See
section "Settings Window" on page 36.

3. Installing the Application 3
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4.2. After Configuration

To start the application after it has been configured, proceed as follows:
o
1. Double-click the Content Check icon ﬂ on the server desktop to start the

application. You can also launch the application by double-clicking the executable file
(.exe) in the installation folder.

The application splash screen appears while the application logs into the
MAD database.

MediArchive.DOirector

Version: O01.05

Content Check

Logging on to ..

& Login

Username:

[
Login

To be able to log into the application, you need to belong to a user group that has a role
which allows to use the application.

2. Enteryour username and password and click Login.

The main window of the application opens.

You get an error notification if:

* you have entered a wrong username or password.
& Login

Username: BEBO

4 4. Starting the Application
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* you have omitted your username.

& Login

lsernarne:

» you have insufficient user rights.
% Login

Username: BBO

» yourlogin has expired.
& Login

sername: BEO

FI =} 1K d g B

Warning
If you have lost your password, a new password will have to be set in
MAD Config. Contact your system administrator.

4. Starting the Application 5
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4.3.

Version and License Check

Introduction

The version of the application and the validity of the application license will be checked
when the application logs into the MAD database at startup. The status of the version or
the license that is returned is displayed on the application splash screen.

Version and License Statuses

The following version and license statuses can be returned:

Status Description Color Action Required
Current The actual version of the application. no No action required.
color

The application starts
automatically.

Outdated A newer version of the application red Click OK to start the
exists, but this version can still be application at once.
used.

By default, the
The application version that should be application starts
installed is displayed. automatically after 10
seconds.

Obsolete A newer version of the application red Click OK to continue.
exists and must be used. This version
may not be used anymore. The application shuts

down.

The application version that should be
installed is displayed.

Undefined The version of the application is not black ' Click OK to continue.

defined in the MADdatabase.
The application shuts
down.

Beta A test version. blue Click OK to start the
application.

By default, the
application starts
automatically after 10
seconds.

4. Starting the Application
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Status Description Color Action Required

License The license period is about to expire. It | orange Click OK to start the

About to | is shown in how many days the license application at once.
Expire will expire.
By default, the
Contact your system administrator or application starts
check the License Controller manual. automatically after 10
seconds.
License The license period has expired. The red Click OK to continue.
Expired date when the license expired is
displayed. The application shuts
down.

Contact your system administrator or
check the License Controller manual.

No Valid There was no valid license found inthe  red Click OK to continue.
License database.
The application shuts
Contact your system administrator or down.
check the License Controller manual.

Maximum @ The maximum number of instances red Click OK to continue.

Licenses <NUMBER OF LICENSES> for the

Reached | license has been reached. The application shuts
down.

Contact your system administrator or
check the License Controller manual.

4. Starting the Application 7
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4.4, Main Window

General Description

The Content Check main window displays the content (= quality) checks being performed
by Baton on the high-resolution video file of segments that have been successfully
ingested into the digital archive.

The faulty video files are picked out and listed at the bottom of the window. The user can
open a detailed error report and play back a low-resolution version to check the errors. The
user can manually accept or reject each video file.

Accepted files will remain in the archive, rejected files will have to be purged from the
archive.

lHlustration

The main window contains the areas highlighted on the screenshot below:

1 2
000000029-40- | Roland G| Federer |Set1 | SD Content 63% |Running |00:00:00:00 |Success
000000029-40- | Raland G| Federer |Set 2 S0 Conkent 35 % Running | 00:00:00:00 |Warnings
000000029-4D- | Raland G| Federsr (Sst S SO Conkent 35%  |Running |00:00:00:00 |'Warnings
000000029-4D- | Roland G| Federer |Set4 | 5D Conkent 98 % W | Running | 00:00:00:00 |Warnings

i

0D0DD0029-30-AAAA. I |Roland Garros 200 |Safina vs  |Set | MXF AVC Intra
000000029-3D-AAAB.m [Roland Garros 200 |Safinavs |Set2  |HD MXF AVC Intra |Fadure
000000029-3D-AAAC. [Roland Garros 200 [Safinavs [Set3  [HD MXF AVC Intra |Failure

il

|-

000000030-HBS-AAAA, |Roland Garros 200 |Gonzalez | Set 1 5D MXF IMX40 J
000000097-3DRIGHT-A |Roland Garros 200 |Sodering | Set 1 S0 MXF IMX40 4
3

8 4. Starting the Application
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Area Description

The table below describes the various parts of the main window:

Part Name Description
1. Menu bar The menu bar contains three menus: File, Settings
and Help.

2. Checks in Progress grid This grid displays the content checks that are being
performed. See section "Checks in Progress Grid"
on page 11.

3. | Failed Checks grid This grid displays the video files that did not pass the
content check tests. See section "Failed Checks
Grid" on page 13.

Menu Bar

The menu bar contains three menus: File, Settings and Help.

File Menu

The File menu contains two commands: Logout and Exit.

Click the File menu or use the keyboard shortcut keys ALT + F or F10 + F to open it.
Click Exit or use the keyboard shortcut key X to exit the application.

Click Logout or use the keyboard shortcut key O to log out of the application.

Settings Menu

The Settings menu does not contain any commands. It immediately gives access to the
application settings. Click the Settings menu or use the keyboard shortcut keys ALT + S
or F10 + S to access the settings.

Help Menu

The Help menu contains the following commands: Help, Context-Sensitive Help and
About.

With the Help command you can open the application help file.

With the Context-Sensitive Help command you can turn on or off the context-sensitive
help mode. In context-sensitive help mode, when you click a user interface item, help for
that item is displayed. You can also turn on or off context-sensitive help mode by pressing
F1.

With the About command the application about box can be opened. The about box
displays the application software version, the date until which the application license is
valid, the name and version of the database the application is logged on to and the login
name used.

Click About or use the keyboard shortcut key A to open the application about box.

4. Starting the Application 9
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MediArchive.Director

Version: O1.05%

Content Check
Application: 2.5.2.0
Database: RO0137
License: 21-DEC-2016

Logged on to [DatabaseName]

10
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5.

5.1.

5.1.1.

Chedks in progr

L 000000023-4

Managing Content Checks

Monitoring Content Check Tasks

Checks in Progress Grid

Introduction

The Checks in Progress grid displays information about the content check tasks that
Baton is performing on the ingested high-resolution video files. Between brackets, the
number of content check tasks is displayed.

Job Duration Result

Foland 5| Federer S0 Conkent Running [ Q0:00:00:00 { Success
000000029-41| Roland G| Federer|Set 2 S0 Conkent 35 %6 Running | 00;00:00:00 [ \Warnings
000000029-41| Roland | Federer| Set 5 S0 Conkent 35 %0 Running | 00:00:00:00 [ \Warnings
000000029-4{| Roland G| Federer S0 Conkent Running | 00:00:00:00 | Warnings

Monitoring Information

For each content check task, the following information is displayed:

Column Description

Filename The name of the video file that is being checked.

Title The name of the grouping category.

Subtitle The name of the asset.

Segment The name of the segment.

Test Plan The name of the Baton test plan used to verify the video file. See
below for more information.

Priority The priority of the content check task.

Progress The progress of the content check task.

Scheduled at
Status
Job Duration

Result

The creation time of the content check task.
The status of the content check task.
The duration of the content check task.

The result of the content check task.

5. Managing Content Checks
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States and Results of a Content Check Task

The table below describes the various content check task states:

State Description

Ready The task waits for the availability of a checker server.
Running | Thetask is assigned to a checker server and starts running.
Cancelled The task is removed before the verification begins.

Aborted The task is terminated before completion and the result is not available.

When a content check task is running or has been completed, the following results are
available for the video file:

Column Description

Success  The video file has no errors or warnings.
Failed The video file has one or more errors; or, the file format is unknown.

Warnings The video file has warnings, but no errors.

Color Codes

The following colors are used to indicate the status of a content check task:

Color  Status

Gray The content check task has not started yet.
Green  No errors were detected in the video material during the content check.
Orange Minor errors were detected in the video material during the content check.

Red Maijor errors were detected in the video material during the content check.

Test Plan

To verify a video file, you need to check the content against a checklist that defines what
features of the content need to be checked and what are the accepted characteristics of
each feature. For example, the checklist may define checks for required resolution, bit
rate, chroma format, frame rate, audio level, and more. At the same time, the checklist
may define some directives on how the content should be checked.

A Test Plan, in simple words, is a checklist for a set of media files. During a content
check task, Baton uses the specified Test Plan to check and verify a set of video files.
During verification if there are any violations in the content against specifications in the
Test Plan, Baton reports errors.

12 5. Managing Content Checks
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5.1.2. Failed Checks Grid

Introduction

The Failed Checks grid displays the segments whose high-resolution video file did not
pass the content check tests. Between brackets, the number of failed content checks is
displayed.

Result
HD MXF AVC Intra Failure
HD MXF AVC Intra Failure
HD MXF AVC Intra Failure
SD MXF IMX40  Failure
HD MXF AVC Intra Faiure |
SD MXF IMX40  Failure

Subtile Segment Test plan

Roland Garros 2009 |Safina ws|Set 1
Roland Gatros 2009 [Safing vs|Set 2
Roland Garros 2009 (Safing vs|Set 3
Roland Gatros 2009 |Gonzdlez (Set 1
Roland Garros 2009 [Gonzalez (Set 2
Roland Gatros 2009 |Gonzdlez (Set 1
Roland Garros 2009 |Séderling|Set 1 SO MXF IMX40  Failure
Roland Garros 2009 |Sdderling|Set 2 S0 MXF IMX40 Failure
Roland Garros 2009 |Séderling|Press Con|S0MXF IMX40  Failure
Roland Gatros 2009 |Sdderling|Press Con|SD MXF IMX40

Roland Garros 2009 |Séderling|Set 1 S0 MXF IMX40

Roland Gatros 2009 | Cibulkeovd Set 1 S0 MYF IMX40

Monitoring Information

For each video clip in the Failed Checks grid, the following information is displayed:

Column Description

Filename The name of the video file that did not pass the content check tests.

Title The name of the grouping category.

Subtitle The name of the asset.

Segment The name of the segment.

Tape Status  The status assigned to the corresponding asset item in Media Manager
by the user. See the Media Manager user manual for more information.

Test Plan The name of the test plan used to verify the video clip.

Result The result of the content check.

The View Error Report button used to open the Error Inspector
window. See section "Error Inspector Window Overview" on page 14.

The Accept button used to accept the video file.

The Reject button used to reject the video file.

5. Managing Content Checks
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5.2.

5.2.1.

If the content check was aborted for a particular video file, because for example there was
an issue with Baton, then the View Error Report, Accept and Reject button will be
unavailable.

Aborted [ e15%]

The Baton Quality Check action will have to be retried in Media Manager.
Accepting and Rejecting Files

Analyzing the Detailed Error Report

Error Inspector Window Overview

General Description

The Error Inspector window gives you detailed information about the errors, warnings and
information in a video file that has been verified by Baton. To open this window for a

particular video file, click the corresponding View Error Report button E]

lllustration

The Error Inspector window contains the areas highlighted on the screenshot below:

Croatia vs. South Africa - 1st Half

The Matrix does not
imatch the

mm-muu An average of 1.23% pixels were found to be

|Oul Out-of-Gamut in a sequence, starting at 00:00:00:000 and
duration of 720 millisecs, Restricton Specified: Percentage
of pixels: 1,00, Maximum Burst should be less than or
equal to 500 millseconds

An average of 1.74% pixels were found to be
Out-of-Gamut in a sequence, starting at 00:00:01:280 and
u-mﬁzmm Restriction Specified:

: Percentage
imldb-lmm:rlwdh um

Video Signal Levels in the An average of 2. 15% pixels were found to be out of Video
|video does not match the Signal Levels range in a sequence, starting at

14

5. Managing Content Checks
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Area Description

The table below describes the various parts of the Error Inspector window:

Part Name Description

1. Navigation buttons The Navigation buttons are used to move back
and forth between the error reports of the video
files.

2. Accept and Reject button The Accept button is used to accept a video
file. See section "How to Accept a Video File"
on page 22.

The Reject button is used to reject a video file.
See section "How to Reject a Video File" on
page 22.

&k Export, Close and Play button The Export button is used to export the error
report to Excel.

The Close button is used to close the Error
Inspector window.

A Play button [> is provided to open a video
player and to play back the part of the low-
resolution video file that contains the error. See
section "Playing Back Video Files" on page 18.

4. Error grid The Error grid displays detailed information
about the minor and major errors and warnings
that have been detected during the content
check of a particular video file. See section
"Error Information" on page 16

B Show Warnings check box The Show Warnings check box is used to
show or hide warnings.

Depending on the settings, this check box will
be selected or unselected. See section "General
Tab" on page 39.

5. Managing Content Checks 15
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Navigation Buttons

The Navigation buttons are used to move back and forth between the error reports of the
video files. The table below describes each button:

Button Name Description

First Segment This button is used to move to the error report of the
first video file in the Checks Done grid.

Previous Segment This button is used to move to the previous error report.

Next Segment This button is used to move to the next error report.

Last Segment This button is used to move to the error report of the
last video file in the Checks Done grid.

Error Information

The Error grid displays detailed information about the errors and warnings that have been
detected during the content check of a particular video file. For each error or warning the
following information is displayed:

Column Description

Timecode  Displays the timecode when the error occurred.

Severity Displays the severity of the error.

Stream Displays the stream where the error occurred, e.g. MXF, MPEG2 Video,
AES3 Audio, DNxHD Video, LPCM Audio, MP4 File.

Type Displays the type of content check. In most cases, this will be a video or
audio check.

Synopsis Gives a summary of the error.
Description Describes the error in more detail.

Thumbnail Displays the erroneous thumbnail, if any.

16 5. Managing Content Checks
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Content Check Categories

The checks are grouped under the following categories:
* Audiolvideo quality checks: checks on decoded audio/video.
E.g. blurriness, blockiness, RGB gamut errors, audio silence, transient noise, etc.
» Audiolvideo description checks: checks on audio/video encoding done.
E.g. resolution, chroma format, frame rate, display aspect ratio, etc.
» Container format specific checks: checks which are specific to the container files.

E.g. number of PCR PIDs/PMT PIDs in MPEG-2 Transport streams, time code track
in MXF files, field location table (FLT) in GXF, Creation/Modification Time MP4 files,
etc.

+ Elementary format specific checks: specify checks which are specific to the
elementary audio/video essences.

E.g. scan order of H.264 video, VITC PAL information in MPEG-2 video, TNS data in
AAC audio, etc.

» Verification Directives: directives specify options to control the verification process.

+ Container description checks: checks on the container encoding done. These
checks are available only for the container formats.

E.g. content layout, size of the file, number of audio/video tracks, etc.

Possible Errors

See the user manual of Baton for more information.

5. Managing Content Checks 17
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5.2.2. Playing Back Video Files

Video Player Overview

General Description

The video player allows you to play back the low-resolution version of a particular video
file to check the errors and warnings.

To open the video player, click the Play button @ in the Error grid.

lHlustration

The video player contains the areas highlighted on the screenshot below:

(6) ., .| 00:59:56:12
T2 ' IN & OUT

18 5. Managing Content Checks
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Area Description

The table below describes the various parts of the software player:

Area Name

Description

1.  Video Display

2. Timecode field

3. Mark All,
Markln,
SnapShot and
MarkOut button

4. Timeline

5. Audio Channel
Left and Audio
Channel Right
field

6.  Navigation
buttons

The file is played back in the video display.

The Timecode field displays the timecode value
corresponding to the current position of the file being played
back.

The Mark All button is used to mark an In point at the start
timecode of the video file and to mark an Out point at the end
timecode.

The Markln button is used to mark an In point.

The SnapShot button is used to take a screenshot of a
particular frame of the source file.

The MarkOut button is used to mark an Out point.

The Timeline visually represents the duration of the video file.
The playhead marks the current position in the Timeline. You
use the playhead to scrub, or play back from its current
position.

The Audio Channel Left and Audio Channel Right field
are used to select the left and right audio channel. These
channels will be played back when starting the player. By
default, eight left and right channels are available.

The Navigation buttons are used to navigate through the
loaded file.

Navigation Buttons

The following navigation buttons are available:

Button Name

Description

- GotoStart
- Rewind

This button is used to move to the start of the video file.

This button is used to move backward through the loaded
video file at a speed faster than real time.

This button is used to play back the video file.

5. Managing Content Checks
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Name

Description

vy}
- (=
* =
[]
=

Pause

Fast Forward

GotoEnd

GotoMarkin

Jog Reverse

Preview

Jog Forward

GotoMarkOut

This button is used to pause the video file.
This button is used to move forward through the loaded
video file at a speed faster than real time.

This button is used to move to the end of the video file.

This button is used to move to the In point.

This button is used to move backward through the loaded

video file frame by frame.

This button is used to play back the video file from the
newly marked In and Out Point.

This button is used to move forward through the loaded
video file frame by frame.

This button is used to move to the Out point.

20
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Navigating Within a Loaded Video File

You can navigate within a loaded video file in several ways.

You can:

click at a specific point on the timeline; or

drag the playhead; or

manually enter a timecode in the Timecode field; or
click one of the Navigation buttons.

use the Shuttle Pro.

See section "General Tab" on page 38 for more information on how to configure Content
Check so that a ShuttlePRO device can be used to control the video player.

5. Managing Content Checks 21
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5.2.3.

5.2.4.

How to Accept a Video File

You can accept video files in two locations:
* inthe Failed Checks grid

* inthe Error Inspector window

To accept a video file, proceed as follows:
1. Click the Accept button.

A message appears asking you to confirm the action.

Confirm x

® Are you sure you want to accept MADOOOO 11297

2. Click Yes to continue or press Y or ENTER.

The record will disappear from the Failed Checks grid. In Media Manager, in the
Segments tab of the Technical Form of the corresponding asset item, the colored bar
under the icon of the Baton workflow action will turn green, indicating that it was
performed successfully. The next action in the workflow will be automatically
selected. See the Media Manager user manual for more information.

How to Reject a Video File

You can reject a video file in two locations:
* inthe Failed Checks grid

* inthe Error Inspector window

To reject a video file, proceed as follows:
1. Click the Reject button.

A message appears asking you to confirm the action.

Confirm x

® Are you sure you want to reject MADQOOO 11297

2. Click Yes to continue or press Y or ENTER.

The record will disappear from the Failed Checks grid. In Media Manager, in the
Segments tab of the Technical Form of the corresponding asset item, the colored bar
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under the icon of the Baton workflow action will turn red, indicating that the action
went wrong. In Media Manager, the user can request a purge of the video file from the
archive. See the Media Manager user manual for more information.
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6.

6.1.

6.2.

6.2.1.

Managing Grids

Introduction

In Content Check most of the data is displayed in grids. Each grid consists of a number of
columns containing specific information.

Content Check provides you a number of features to customize each grid.
You can:
» adjust the width of each column

« sort and filter data.

Manipulating Columns

Adjusting the Width of Columns

The width of each grid column can be manually or automatically adjusted.

How to Manually Adjust the Column Width

To manually adjust the width of a particular column, drag the right or left border of the
column header until the column has the desired width.

To manually change the width of a column to fit its contents, double-click the boundary on
the right side of the column header.

If you hold your cursor over a column header border, it will change into a double-headed
arrow.

AL

Keep Online Expire Date .'TI:I:--:atin:-n

How to Automatically Adjust the Column Width

To automatically adjust the width of a column to fit its contents, right-click the column
header, and then select the Best Fit option from the context menu.

To automatically adjust the width of all columns to fit their contents, right-click the column
header, and then select the Best Fit (all columns) option from the context menu.

I Best Fit

Best Fit (all columns)

24

6. Managing Grids



USER MANUAL MAD 1.5 Content Check I / .

6.2.2.

Reordering Columns

If you want the information in a grid to be displayed in a different order, you can change the
position of the columns. There are two ways to reorder columns.

How to Reorder a Column Using a Drag-And-Drop Action

To reorder a column by directly dragging its header, proceed as follows:

1.

Click the header of the column you want to move and hold down your left mouse
button.

Drag the column header to the desired position in the grid.

Two arrows will indicate where it is possible to insert the column.

Status ¥

A black prohibition sign will indicate where the column cannot be inserted.

Release the left mouse button to insert the column.

How to Reorder a Column Using the Show/Hide/Move
Button

You can also reorder the columns of a grid by using the Show/Hide/Move button:

1.

Click E on the left side of the first column header.

A drop-down list containing the headers of the grid columns appears. The column
headers are listed in the order in which the columns are displayed in the grid. The first
header in the list is the leftmost field in the grid. The columns that are visible in the grid
are selected.

The headers in the screenshot below can differ from the headers available in your
application.

n 2rd, Mame

2. Select a header and drag it to the desired position in the list. Green arrows will appear

indicating where you can insert the grid.

6. Managing Grids
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6.2.3.

n Ord, Mame
T ord,

" Mame

" Descripkion

In the grid, the column will be moved to the new position.

Adding and Removing Columns

If you want more or less information to be displayed in a particular grid, you can simply
add or remove one or more columns.

How to Add a Column

To add a column to a grid, proceed as follows:

1.

Right-click the header of a column, and then select the option Field Chooser from the
context menu.

Remave This Column

Field Chooser

A dialog box appears with a list of predefined columns you can add to the grid. Note
that the column headers shown in the screenshot below can differ from the ones
displayed in your application.

Customization

Columns

From the list, select the header of the column you want to add to the grid.
Drag the column header to the desired position in the grid.

Two green arrows will appear indicating where you can insert the column.

Status T

A black prohibition sign or cross will appear if you try to insert the column in a location
where it cannot be inserted.
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6.2.4.

4. Release the left mouse button to insert the column.

How to Remove a Column

To remove a column from a grid, right-click its header and then select the option Remove
This Column from the context menu.

Removwe This Column
Field Chooser

The column will disappear from the grid and its header will be added to the dialog box
containing the columns that can be added to the grid.

The removed column can be added again to the grid.

Hiding and Unhiding Columns

You can temporarily hide columns from a grid without having to remove them. Afterwards,
you can easily make them visible again.

How to Hide a Column
To hide a particular column from a grid, proceed as follows:

1. Click the Show/Hide/Move button Ea in the top left corner of the grid.

A drop-down list will appear with the available columns.

n Crd, Mame

2. Deselect the check box next to the header of the column you want to hide from the
grid.

How to Unhide a Column
To make a hidden column visible again, proceed as follows:
1. Click the Show/Hide/Move button Ea in the top left corner of the grid.

A drop-down list will appear with the available columns.

6. Managing Grids
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6.3.

6.4.

Ord, Mame
T ord,
" Mame

Description

w
.l
-
W

" Skatus

2. Select the check box next to the header of the column you want to make visible again.

Copying Data

To copy the data of a particular grid row to the Clipboard, proceed as follows:
1. Select the appropriate row in the grid.
2. Press CTRL+C.

Sorting Data

Each grid can be sorted according to the values in one of the columns. You can sort text
(from A-Z or from Z-A), numbers (from low to high or from high to low).

How to Sort Data by Clicking a Column Header

To sort the data in a particular column, click the column header once to sort the data in
ascending order. Click again to sort the data in descending order. An arrow next to the
column header indicates the sorting method.

sorted in ascending order
sorted in descending order

How to Sort Data by Using the Context Menu

You can also sort the data in a particular column by right-clicking the column header and
selecting the desired sorting method from the context menu.

%l Sort Ascending
El Sort Descending
Clear Sorting

To clear the sorting in a particular column, right-click the column header and select the
option Clear Sorting from the context menu.
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6.5. Filtering Data

You can filter the data in a grid by using two types of filters: by one or more values from a
particular column or by simple or complex criteria.

6.5.1. Filtering by Values From a Column

To filter the data in a particular grid by one or more values from a particular column,
proceed as follows:

1. Hold your cursor over the header of the column by whose values you want to filter the
grid, and then click the filter button.

A drop-down list opens containing all the column values.

2. Select the desired values.

Only the records that contain one of the selected values are displayed in the grid. At
the bottom of the grid a filter bar appears displaying the applied filter.

Customize...

< ¥ (Type = Opener)

3. Inthefilter bar, do one of the following:
o Clearthe check box next to the filter @ to undo it. Select the check box to apply
the filter again.
o Click I to undo the filter and close the filter bar.
o Click e to open a drop-down list containing previously applied filters.

o Click Customize to create a complex filter.
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6.5.2.

Filtering by Criteria

Filters by criteria can be simple or complex:

Simple filters consist of one or two criteria and one Boolean operator (AND or OR).

Complex filters consist of more than two criteria and more than one Boolean operator
(AND, OR, NOT AND and NOT OR).

How to Create a Simple Filter

To create a simple filter, proceed as follows:

1.

Hold your cursor over the header of the desired column, and then click the filter button
appearing in the right corner.

From the drop-down list, select the option (Custom...).

The Custom Filter dialog box appears. Here you can enter the criterion or the two
criteria you want to filter the values of the selected column by.

Custom Filter

Select the desired comparison operator from the first drop-down list.

A comparison operator is used in comparison criteria to compare two values.
Operators include: ‘equals’, ‘does not equal’, ‘is less than’, ‘is less than or equal to’, ‘is
greater than’, ‘is greater than or equal to’, ‘like’, ‘not like’, ‘is blank’ and ‘is not blank’.

For example, if you want to filter the values of a column by text that includes a certain
word, character or sign, you have to select the comparison operator ‘like’.

Enter text in the field next to the first drop-down list.

For example, if you want to filter by text that includes the letter ‘'S’, type %S%.
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The % wildcard can substitute for zero or more characters. The _ character can
substitute for exactly one character.

5. If you want to add a second filter criterion, select the desired Boolean operator. Select:
o AND, if both criteria have to be true;
o OR, if at least one of the criteria or both have to be true.

6. Select the desired comparison operator from the second drop-down list, and then enter
text in the field at the right.

7. Click OK to apply the filter.

Only the values matching the entered criterion or criteria will be displayed.

How to Create a Complex Filter
To create a complex filter, proceed as follows:

1. Apply a simple filter to a grid or filter a grid by selecting one or more values from a list
of values. See above.

At the bottom of the grid afilter bar appears.

2. Inthefilter bar, click the Customize button.

A dialog box appears that allows you to create complex filters. The criteria of the
active filter are displayed in a tree structure. Here you can add extra criteria and
change the existing criteria.

? Filter builder - [untitled.flt]

Filter

press the button to add a new condition

3. Do one of the following:
» Toadd anew criterion, do one of the following:
o click the Press the Button to Add a New Condition button;

o click the Filter button and select Add Condition;

o click ' next to a criterion and select Add Condition.
» Tochange a criterion, do one of the following:

o click a column header (green and underlined text) and select another value from
the list;
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o click a comparison operator (dark red and underlined text) and select another
value from the list: ‘equals’, ‘does not equal’, ‘is less than’, ‘is less than or equal
to’, ‘is greater than’, ‘is greater than or equal to’, ‘like’, ‘not like’, ‘is blank’, ‘is not

[FPS

blank’, ‘between’, ‘not between’, ‘in’, ‘not in’;

o click the dark blue text on the right of the comparison operator and enter another
value.

To delete a criterion, click the ! button to the left of the criterion and select the option

Remove Row.

To add a group of criteria, do one of the following:

o click ' next to a random criterion and select Add Group;

o click the Filter button and select Add Group.

To delete all criteria, click the Filter button and select the option Clear All.
Do one of the following:

o Toopen an existing complex filter, click Open;

o Tosave the current filter, click Save As;

o To confirm the changes and close the dialog box, click OK;

o Toundo the changes, click Cancel.

o Toapply the changes, click Apply.

At the bottom of the grid a bar appears which displays the components of the complex
filter. Note that if you have already created a custom filter in the past, you can reapply
it by clicking the current filter or the downward pointing arrow. A drop-down list
containing previous filters appears.
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6.6. Performing Basic Calculations on
Data

6.6.1.

Footers and Basic Calculations

You can perform basic calculations on the data in a grid by adding footers.

Types of Footers

Two types of footers can be distinguished:

» Grid footer: Footer added at the bottom of a grid allowing you to perform calculations

on all values in a particular column.

* Group footer: Footer added at the bottom of a group allowing you to perform

calculations on the values of a particular column in that group.

The result of a calculation performed on the data of a particular column is displayed in a
footer cell below the column in the grid or group footer.

Basic Calculations

Right-clicking a footer cell in a grid or group footer will open the footer context menu.

This menu will allow you to select or change the type of calculation that should be

performed on the data of a particular column.

= Sl
£ Win

j:' Max

N Court
E/g Ayerane

Mone

Depending on the type of data contained in each column, you will be able to perform one or
more of the following calculations:

*  Sum: Adds up all numbers in a column.

*  Min: Defines the lowest value in a column.
» Max: Defines the highest value in a column.
* Count: Counts the elements in a column.

» Average: Calculates the average value of all numbers in a column.

6. Managing Grids
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6.6.2. Performing Basic Calculations on Non-
Grouped Data

To perform basic calculations on all the data of one or more column, proceed as follows:

1. Right-click the desired column header.

2. From the context menu, select the Footer option.

Q Foaoter

E Group Footers

The grid footer automatically appears at the bottom of the grid.

3. Inthe grid footer, right-click the footer cell below the column whose data you want to
perform calculations on.
A context menu with basic calculations appears.

2 St
Wi

j—) M

N Count
E/,, HErage

Mone

Note
Depending of the type of data in a column (dates, alphanumeric data), all or only

some of the calculations will be available.

4. Select the desired calculation.
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In the footer cell the result of the calculation appears.

01:00:51:07F

6.6.3. Removing Footers

You can remove the grid and group footers and also clear the content of a cell footer. Do
one of the following:

To remove the grid footer or all group footers, right-click any column header and in the
context menu deselect the option Footers or Group Footers.

IE Footer
IE Group Footers

To clear the contents of a cell footer, right-click it and from the footer context menu
select the option None.

Sum
£ Min
j" Max
N cCount

E/;, Average

Mone
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7. Configuring the Application

7.1. Settings Window

Opening the Settings Window
The Settings window allows you to configure your application. The first time the

application is launched after it has been installed, the Settings window opens
automatically.

. Enter into edit mode

User settings Global settings System settings

General

K.enboard

b an action and enter a sharkout to

Shift+Chrl+
Shift+Chel+
Shift+Chrl+0
Chrl+hd
Crl+,

Chrl+F.

Chrl+;

The Settings window can also be accessed through the Settings menu.

Overview Setup Categories

The settings can be divided into three setup categories. In the Settings window, atabis
provided for each setup category. The table below briefly describes each setup category:

Setup Category Description

User Settings These settings can be configured by each individual user.

Global Settings | These settings can only be configured by the system administrator
and by an eventual superuser.

36 7. Configuring the Application



USER MANUAL MAD 1.5 Content Check I / .

Setup Category Description

System Settings These settings configure the general functioning of the application.
They can only be configured by the system administrator.

Edit Mode

To be able to edit the System settings, you first have to enter a password.

To put the Settings window into Edit Mode, proceed as follows:

¢ Enter into edit mode

1. Click the Enter Into Edit Mode button

A dialog box appears.
Password Dialog

Enter password:

2. Enter the administrator password and then click OK.

The Settings window enters into Edit Mode.

Edit Mode

Saving Settings

A Save button is provided which allows you to immediately save the changes you have
made to the settings. With the Cancel button you can discard the changes you have
made.
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7.2.

7.2.1.

7.2.2.

User Settings

Overview User Settings Subcategories

The User settings are divided into the following subcategories:
+ General

For each category a tab is provided.

General Tab

The General tab allows you to configure the control of the video player.
Fevboard

Select an achion and enter a sharkout ko ;

H e I:l (=5 |':[i|:|ti|:| 4l

P Ik b Clut
E]
: S hift+Crl+0
Ctrl-+kd
Clrl+,
Play/Pauze ay/Palze Crl+F.
Gata End Gata End Chls-
b ark. Ir ark. In Chrlel
Park Ot bdark Ot Chrl+0
Jog Left Jog Left Clil+- (PAVE NUM.]
Jog Right Jaog Right

Forward Speed 1 Forward Speed 1 Clrl+&

The Keyboard group box contains the keyboard shortcut keys that have been configured
by default to control the video player.

To change a particular keyboard shortcut key, select it and perform the keyboard shortcut
key you want to use instead. You can also change the description of a particular action.

The video player can also be controlled with a ShuttlePro device. A .pref file will be
provided by EVS in which the default video player shortcut keys are associated with
ShuttlePro components (e.g. jog wheel, shuttle ring, buttons).

This . pref file has to be imported in the Shuttle Device Control panel, the component of
the software that allows to manage the Shuttle device by defining and/or modifying
application settings. The ShuttlePro device will have to be connected with the server or pc
on which Content Check is installed.

See the ShuttlePRO user manual for more information.
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7.3.

7.3.1.

7.3.2.

Global Settings

Overview Global Settings Subcategories

The Global settings are divided into the following subcategories:
+ General

For each category a tab is provided.

General Tab

The General tab enables you to activate or deactivate the display of warnings in an error
report. You can also specify the path of an alternative storage folder where Content Check
has to look, if it does not find a particular low-resolution video file on the storage. Finally,
you can specify a default snapshot folder.

Reports

Include warnings in eror reparts

bedia

[f widen file iz not found, search in path:

zhat folder:

C:hContent Checkh

Configuring the Display of Warnings
In the Reports area you can configure the display of warnings in the Error Inspector
window.

If the option Include Warnings in Error Reports is selected, warnings are automatically
displayed. The Show Warnings check box will already be selected.

If this option is not selected, the user will have to select the Show Warnings check box
to view warning in the Error Inspector window.

By default, this option is selected.

Specifying an Alternative Storage Location

In the Media area you can specify an alternative storage location.

7. Configuring the Application 39



EVS Broadcast Equipment S.A. Issue 1.5.D - February 2015

If the option If Video File Is Not Found, Search in Path is selected, and Content
Check does not find a particular video file on the online storage, then it will look for the
video file in the location that you have entered in the field provided for this purpose. You

can also browse for a specific folder by clicking =3

By default, this option is not selected.

Specifying a Default Snapshot Folder

In the Media area you can also specify a default folder for snapshots.

The snapshots taken with the video player will be automatically stored in this folder. By
default, the Content Check installation folder is entered as snapshot folder. You can enter

the path of a different folder or browse for it by clicking =3
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7.4. System Settings

7.41. Overview System Settings Subcategories

The System settings are divided into the following subcategories:
Oracle Connection
E-Mail Options

For each subcategory a tab is provided.

7. Configuring the Application
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7.4.2. Oracle Connection Tab

The Oracle Connection tab allows you to configure the connection with the Oracle
database.

Oracle login
Login narne :
Ilze thiz login name

ze autologin

4 Application history

k.eep connection alive interval ;

tirne(z]

4, Test Oracle

Entering the Database Name

In this field you have to enter the name of the database the application has to connect to.

If the Use This Database Name check box is selected, the name of the database will
automatically appear in the Oracle login dialog box at start-up.

Note that the database name will be automatically entered and the Use This Database
Name check box will be automatically selected when you log into the application for the
very first time.

Entering the Login Name

In this field you have to enter a login name. If the Use This Login Name check box is
selected, the login name will automatically appear in the Oracle login dialog box at start-
up.

Note that the login name will be automatically entered and the Use This Login Name
check box will be automatically selected when you log into the application for the very first
time.
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Entering a Password

In this field you have to enter a password. If the Use Auto Login check box is selected,
the application automatically logs into the selected database at start-up. The Oracle login
dialog box does not appear.

Note that the password will be automatically entered and the Use Login check box will be
automatically selected when you log into the application for the very first time.

Checking Application History

By clicking the Application History button, you can open a chronological list of all
software versions of the application. To get more details about each version (creation
date, name of programmer, status, additional remarks), you have to click + next to the
version number.

Activating Keep Alive

If the option Keep Connection Alive is selected, a message is sent to the database at
regular time intervals to avoid idle connections from being closed by the firewall. These
intervals can be set by you.

Note that this option will be automatically selected when you log into the application for
the very first time.

If the option Try to Reconnect if Keep Alive Fails is selected, the application will try a
number of times to reconnect with the database.

If the option Report Status in Database Everytime Keep Alive Timer Triggers is
selected, the status of the connection is reported in the database each time the Keep
Alive Timer sends a trigger to send a Keep Connection Alive message.

Testing the Oracle Connection

The Test Oracle button allows you to check the validity of the database name, login and
username you entered.

If these data are valid, then the following message appears next to the Test Oracle
button: ‘OK’.

If the login name or password is invalid, then a message box appears with the following
message: ‘ORA-01017: invalid username/password; logon denied’.

If the database name is invalid, then a message box appears with the following message:
‘ORA-12154:TNS: could not resolve the connect identifier specified’.

If you omit the password, then a message box appears with the following message:
‘ORA-01005: null password given; logon denied’.

If you do not enter a database name, login and userame, then a message box appears
with the following message: ‘ORA-12560: TNS: protocol adapter error’.
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You can also check the software version of the application by clicking the Test Oracle
button. If the software version is up-to-date, then the following message appears:
‘Current— The Current Version'. If the software version is outdated, then the following
message appears: ‘Unknown Version Application! Please contact the EDP department.’

If you close the Settings window without testing the validity of the database name, login
and username you just entered, then a message box appears.

Information x

or not working properly.

If you click Yes, then the Settings window is closed and the original values are restored. If
you click Cancel, then the Settings window does not close and you can test the values by
clicking the Test Oracle button.

If you change the current database settings, test the connection and then close the
Settings window, a message box will appear.

Information

If you click Yes, the application is stopped and closed. A manual restart will be required.
Click Cancel to continue.
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7.4.3.

E-Mail Options Tab

In case the application is capable of sending e-mail messages, the E-Mail Options tab will
allow you to configure an e-mail account, enter the e-mail address of the default sender
and recipients, and enter a default e-mail subject. If the application is not capable of
sending e-mail messages, the settings in this tab cannot be used.

Send e-mail B Send e-mail

n zettings

Host identifier : SMTF login

Port

Time-out ;

Internal mail settings  E =ternal mail settings

Fram:

Bec:

Subject:

To be able to configure the e-mail account, you have to select the Send E-Mail check
box. The fields in the Mail System Settings and Mail Message Settings group box become
available.

Configuring an E-Mail Account

In the Mail System Settings group box you have to enter the IP address and port number
of the SMTP server and specify a timeout. In the SMTP Login group box you can enter a
user name and password.

Configuring a Default E-Mail Message
The Mail Message Settings group box contains two tabs: Internal Mail Settings and
External Mail Settings.

The Internal Mail Settings tab can be used to configure a default e-mail message that will
be sent to the EVS developers and the customer when an error occurs.

7. Configuring the Application 45



EVS Broadcast Equipment S.A. Issue 1.5.D - February 2015

The External Mail Settings tab can be used to configure a default e-mail message that will
be sent to the customer to notify him about an error. In each tab you have to enter the
sender’s email address, the email address of the various recipients and a subject. It
should be noted that this tab is not always used.

When you insert multiple e-mail addresses in any of the header fields, make sure you
separate them by a comma.

To test the settings and manually send an e-mail message, click the Send Mail button.

For the new settings to take effect, close and restart the application. Check the TOM.ini
fileinthe AppData\Roaming\EVS Broadcast Equipment\MAD\ [Application]
folder for the e-mail addresses and subject entered here.
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